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ABSTRACT

Autonomous vehicles have been rapidly developed as demand that provides safety and efficiency in
transportation systems. As autonomous vehicles are designed based on open-source operating and
computing systems, there are numerous resources aimed at building an operating platform composed
of Ubuntu, Autoware, and Robot Operating System (ROS). However, no explicit guidelines exist
to help scholars perform trouble-shooting due to incompatibility between the Autoware platform
and Ubuntu operating systems installed in autonomous driving systems-equipped vehicles (i.e.,
Chrysler Pacifica). The paper presents an overview of integrating the Autoware platform into the au-
tonomous vehicle’s interface based on lessons learned from trouble-shooting processes for resolving
incompatible issues. The trouble-shooting processes are presented based on resolving the incom-
patibility and integration issues of Ubuntu 20.04, Autoware.AI, and ROS Noetic software installed
in an autonomous driving systems-equipped vehicle. Specifically, the paper focused on common
incompatibility issues and code-solving protocols involving Python compatibility, Compute Unified
Device Architecture (CUDA) installation, Autoware installation, and simulation in Autoware.AI.
The objective of the paper is to provide an explicit and detail-oriented presentation to showcase
how to address incompatibility issues among an autonomous vehicle’s operating interference. The
lessons and experience presented in the paper will be useful for researchers who encountered similar
issues and could follow up by performing trouble-shooting activities and implementing ADS-related
projects in the Ubuntu, Autoware, and ROS operating systems.

Keywords Autonomous vehicle, Ubuntu, ROS, Autoware, Compatibility issue

1 Introduction

An autonomous vehicle (AV) is a self-driving vehicle that can operate and navigate without human involvement.
According to the Society of Automotive Engineers (SAE International), a global professional association and standard
organization, there are six levels of driving automation from level 0 to level 5 [1]. The six levels represent no automation,
automation of one control function (steering or brake/acceleration), automation of two control functions (steering and
brake/acceleration), conditional automation (drivers are expected to control the vehicle when the feature requests),
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high automation (drivers are not expected to control vehicle), and full automation with no human control [1][2]. To
date, autonomous vehicles have been developed and evolved rapidly in transportation systems, improving safety,
mobility, and traffic management. For example, companies such as Waymo and Cruise have successfully implemented
ride-hailing services to provide on-demand transportation for passengers without human drivers [3]-[4]. In June 2024,
Waymo announced that the ride-hailing service is available to everyone in San Francisco [5]. AVs are also gradually
integrated into transportation infrastructure systems that promote road maintenance, smart infrastructure integration
(e.g., vehicle-to-vehicle, vehicle-to-infrastructure, vehicle-to-everything), urban planning, and charging [6][7][8][9].

Both hardware and software stacks support automated vehicles to address efficient and safe vehicle motion. The
hardware stack comprises sensors, a global positioning system (GPS), an actuator, and a control unit; the software
stack includes layers of perception, localization, mapping, planning, and control [10]. Sensors are categorized into two
categories: internal state sensors and exteroceptive sensors. The internal state sensors are also known as proprioceptive
sensors [11] and include global positioning systems (GPS), inertial measurement units (IMUs), odometry sensors,
gyroscopes, and magnetometers. The exteroceptive sensors (aka. External sensors) include cameras, radio detection
and ranging (radar), light detection and ranging (LiDAR), and ultrasonic sensors. The software stack deals with data
collected from sensors and makes decisions on controlling the AVs. The software stack has five layers (i.e., perception,
localization, mapping, planning, and control) that play different roles in the AV system. For instance, the perception
layer gathers sensor data to identify objects in their surrounding environments. Subsequently, the localization layer
uses the data from the perception layer to determine the vehicle’s location. The mapping layer creates a map of the
vehicle’s surroundings and updates it in real-time. The planning layer receives information from perception, localization,
and mapping layers to generate a moving path and movement. Finally, the control layer receives commands from
the planning layer and sends them to the vehicle’s actuators that follow the planning path and immediately react to
surrounding objects (pedestrians, vehicles, traffic devices, etc.).

An autonomous vehicle is supported by a complex system and algorithm, including both machine learning (ML)
and artificial intelligence (AI), to achieve sensor fusion, pattern recognition, simultaneous localization and mapping
(SLAM), and motion prediction. Building an autonomous vehicle is a challenge that requires a middleware framework
to consist of code, pre-built visualization, and testing [12]. The robot operating system (ROS) is a robust framework
for programming autonomous vehicles, which is famous for engineers who want to build their designs. To use ROS
the Ubuntu operating system is a primary platform and widely used distribution for ROS development. Drive-by-wire
(DBW) technology is also essential for autonomous driving systems (ADS) to control AVs through an installed speeding
and steering control (SSC) system that provides electronic control of steering, braking, throttling, shifting, etc. [13][14].
With the development of AVs, the DBW has become more essential for AVs through electronic signals. Nowadays, the
DBW technology integrated into various models has been widely adopted as part of autonomous driving systems by
companies such as Tesla, Uber, Waymo, etc. [13]. The integration and combination of ROS and Ubuntu are crucial
in supporting DBW in autonomous driving and hardware platforms. Engineers can create nodes through ROS topics
and services for communication between nodes and provide real-time commands. Engineers must develop a DBW
system for an AV prototype [13] based on ROS and Ubuntu to successfully achieve an automated driving system. This
stage mainly involves system compatibility and software integration - for example, DBW compiles with autonomous
platforms such as Autoware and CARMA software for autonomous driving. However, based on the currently available
versions of Autoware (Autoware.ai, Autoware.auto, and Autoware.universe) and Ubuntu (Ubuntu 18.04, Ubuntu 20.04)
platforms installed in most ADS-equipped vehicles, many incompatibility issues have occurred during the development
stage when a DBW interfered with an Autoware software. These issues have exposed challenges for users to efficiently
operate ADS-equipped vehicles.

The study aims to provide a technical approach to address the aforementioned incompatibility issues between the
Autoware platform and Ubuntu operating systems in ADS-equipped vehicles. The objective of the paper is to provide
AV users with a framework and methods in a practical way that interested AV users who might have encountered similar
issues can follow to address their respective issues. The following demonstrate our aspects to achieve the objective:

1. Solving incompatibility issues between Autoware.AI and Ubuntu Focal Fossa in the ROS-based DBW platform.
2. Modifying codes based on the Autoware.AI repository.
3. Integrating Autoware.AI to an autonomous vehicle’s SSC and DBW interface for implementations of data

collection, perception, localization, mapping, and planning.
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2 BACKGROUND AND PROBLEM STATEMENT

2.1 Introduction of Robot Operating Systems (ROS)

ROS is a set of software libraries and tools that has been broadly used by researchers and engineers to design automated
driving systems. Ubuntu is an open-source and modern operating system on Linux used for desktops, cloud computing,
servers, and the Internet of Things (IoT). Ubuntu supports different languages and is available to all users worldwide [15].
Two Ubuntu releases are currently available: interim and Long-Term Support (LTS). Interim releases are maintained for
nine months, and LTS is maintained for ten years [16], including standard support and expanded security maintenance
(ESM).

The ROS is a powerful tool that empowers users to build robot applications. ROS provides a platform for users to
develop and use robots, offering seamless coordination between software and hardware. With ROS, users can build
various components, from actuators and sensors to control systems, using ROS tools – topics and messages [17]. These
messages can then be recorded using logs or ROS bag files for further training and testing. The ability to visualize work
with a simulated robot in the ROS environment further enhances ROS’s versatility. It is no wonder that ROS is widely
used in robots and autonomous driving projects, with over 500 million ROS packages downloaded in 2020 by research
labs, companies, and government agencies [17][18].

2.2 Autoware platform

Autoware is an open-source autonomous driving software built on a ROS platform. It facilitates the commercial
deployment of autonomous driving in various vehicles and applications. Autoware offers three versions, namely
Autoware.AI, Autoware.Auto, and Autoware Core/Universe. Autoware.AI, the pioneering version, was released based
on ROS 1. Its extensive adoption by over 100 companies across 20 countries by 2022 [12] is a testament to its
proven track record, reliability, and effectiveness. The Autoware.AI repository is a rich source of various packages
covering sensing, perception, localization, mapping, planning, and actuation. Autoware.Auto, the second distribution,
was released based on ROS 2 [19]. It is not just software but a solution that addresses the main challenges of road
conditions in an autonomous driving system. For example, it ensures stability and resilience for the system’s perception,
localization, planning, and control, even in adverse weather conditions or unpredictable traffic situations [20]. To further
enhance Autoware. Auto’s development, the Autoware Core/Universe, was introduced.

The architecture of Autoware, as depicted in Figure 1 [8], is a testament to its comprehensive capabilities. It comprises
three main components: sensing, computing, and actuation. The Sensing component incorporates common vehicle
sensors such as cameras, LiDAR, radar, IMU, and GPS. The computing component is further divided into perception,
decision, and planning. Perception in Autoware involves localization, detection, and prediction. Localization is achieved
through 3D maps and simultaneous Localization and Mapping (SLAM) algorithms with IMU and GNSS. Detection is
performed using cameras and LiDARs, along with a fusion algorithm and deep neural networks. Prediction is closely
tied to localization and detection. The decision module, a key component, is not just a module but a sophisticated system
that incorporates intelligence and state. For instance, the driving behavior of automated vehicles can be determined
based on the perception results, and then an appropriate planning function can be selected. The planning module,
the final component in computing, is responsible for creating plans for mission and motion based on the results of
perception and decision. Autoware generally generates plans for global trajectories based on the current location, while
local trajectories are generated by the motion planning module and global trajectories [21]. The actuation component
controls the vehicle’s acceleration, steering, and brake. The local trajectories are determined after the sensing and
computing modules.

2.3 Current issues encountered

The Autoware.AI repositories were stopped updating in June 2022 and transitioned to ROS2 rather than ROS1. This
transition has significant implications for researchers, as it changes the way Autoware.AI is installed and used. Generally,
Autoware provides an installation document to help users install Autoware.AI for different Ubuntu releases. However,
most researchers have more experience in ROS1, and Autoware.AI is the most appropriate version for them when
designing an autonomous driving project. During the installation process, researchers encountered issues such as
incompatibility problems between Autoware.AI and ROS 1 based on Ubuntu 20.04. For example, compatibility
issues have been noticed in ROS packages when launching Autoware.AI in an ADS-equipped vehicle. Integrating the
vehicle interface with the Autoware platform is a constant challenge. For instance, how to generate a point cloud map
downsample and set up parameters in Runtime Manager for simulation has created numerous incompatibility issues
between Autoware.AI and Ubuntu 20.04 operating systems.
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Figure 1: An overview of Autoware.AI (source:22 [22]).

Table 1: Computer setup

Spectra ECU
Interl i9-9900 9th Gen 3.10/5.0GHz hexa-core
NVIDIA Quadro RTX-A4000 GPU (NVIDIA-SMI 470.199.02)
512GB M.2 2280 NVMe SSD
4 port GigE PoE PCle Card
Kvaser PCleCAN 4xHS

Sensor Sepcification
Camera: Mako G-319C cameras
Radar: Delphi ESR 2.5 RADAR
LiDAR: Velodyne (VLP-32-C-B) 32 Element Sensor
GNSS: GNSS Positioning – Novatel kit

3 HARDWARE AND OPERATING SYSTEM in an ADS-EQUIPPED VEHICLE

3.1 Hardware specification

The testing vehicle used for the study is owned by the University of Nebraska-Lincoln (UNL), which was purchased
from a motor vehicle dealer and had it converted to an ADS-equipped vehicle by a third party. The specifications of
the testing AV are shown in Table 1. As per Autoware Foundation [23], to fully install Autoware.AI in an AV, the
recommended system specifications, including CPU, RAM size, and storage size, must meet the requirements. Based
on the experience, we suggest a CPU with eight cores, 32GB RAM, at least 64GB storage size, and an NVIDIA GPU
(optional). The AV is equipped with a range of sensors strategically placed for optimal performance, playing a vital
role in Autoware integration. The AV’s sensors include two cameras, radar, LiDAR, global navigation satellite system
(GNSS), GNSS Antenna, and spectra, which provide the specifications of all sensors equipped in the testing AV.

3.2 ROS-based Ubuntu platform

When installing Ubuntu 20.04.6 LTS (Focal Fossa), it’s important to note that Windows is the default operating system.
We recommend installing Ubuntu through an Ubuntu image [16]. ROS Noetic, the last ROS 1 version, is supported by
Ubuntu 18.04 (Bionix Beaver). The default software installed in the testing AV included ROS 1 on Ubuntu 20.04 (Focal
Fossa), which features Python 3 and Gazebo 11 for further Autoware installation.
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Figure 2: Install system dependencies for Ubuntu 18.04/Melodic (source: [23]).

Installation of system dependencies After the ROS-based Ubuntu platform is tested in the AV without any further
issues, the next step is to install Autoware.AI on the AV’s PC. Two options are available for users to download
Autoware.AI on the website: one is Docker, and the other one is source build. In this study, we downloaded Autoware.AI
from the source build to further integrate the vehicle interface with the Autoware platform. The recommended Ubuntu
version for supporting Autoware.AI includes Ubuntu 14.04, 16.04, and 18.04. All versions require ROS, Qt, CUDA
(optional), FlyCapture2 (optional), and Armadillo (optional). Based on the current operating system (i.e., Ubuntu 20.04)
in the testing AV, we started installing system dependencies for Ubuntu 18.04/Melodic, which is the latest version
that supports Autoware, following the instructions (Figure 2) to configure Ubuntu 20.04. Compute Unified Device
Architecture (CUDA), a parallel computing platform and programming model developed by NVIDIA for graphics
processing units (GPU), is recommended to be installed for running Autoware.

4 INCOMPATIBILITY ISSUES

As mentioned previously, we encountered a few issues due to the incompatibility between the default software
and devices. Therefore, this section showed our approaches using coding and programming commands to resolve
incompatibility issues between the Autoware platform and the AV’s interface. The solution codes and error messages
are provided during the installation in the study for interested users to follow for troubleshooting purposes.

4.1 Python version management

Ubuntu 20.04 is compatible with both Python 2 and 3. Python 2 is the default interpreter when executing the Python
–V command. To change the system’s default Python interpreter setting, execute commands in the Terminal under the
ROS-based Ubuntu environment, such as sudo ln -s /usr/bin/python3 /usr/bin/python.

"python-catkin-pkg" has no installation Try several commands:

sudo apt install -y python3-catkin-pkg python3-rosdep ros-$ROS_DISTRO-catkin
sudo apt install -y python3-pip python3-colcon-common-extensions python3-setuptools
python3-vcstool
pip3 install -U setuptools

No module named "wx" Install wxPython using commands as follows; either works.

python3 -m pip install -U -f https://extras.wxpython.org/wxPython4/extras/linux/gtk3/
ubuntu-20.04 wxPython
sudo pip3 install wxpython.

wxPython verification python3 -m pip

4.2 System dependencies (e.g., CUDA)

Checking CUDA version First, check the CUDA version using the nvcc –version command. If no information is
shown in the Terminal, install CUDA by referring to NVIDIA’s official web regarding the GPU product. We solved this
issue using the following commands [24].

1. Add repository for CUDA 11: wget https://developer.download.nvidia.com/compute/cuda/
repos/ubuntu2004/x86_64/cuda-ubuntu2004.pin

2. Add public key:
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sudo mv cuda-ubuntu2004.pin /etc/apt/preferences.d/cuda-repository-pin-600
sudo add-apt-repository "deb http://developer.download.nvidia.com/compute/cuda
/repos/ubuntu2004/x86_64/ /"

3. Upgrade the installed packages and check the CUDA version. sudo apt update and sudo apt install
nvdia-cuda-toolkit-VERSION

4.3 Autoware.AI installation

Autoware.AI was directly downloaded from the Git repository of the AV contractor’s contractor, and the software was
customized after the repositories were cloned from the contractor.

Creating project directory We created a main directory, ’autoware.ai,’ for Autoware.ai, and then a subdirectory,
"src," for the source files using the following commands:

mkdir -p autoware.ai/src

cd autoware.ai/src

Cloning the repositories from the contractor There are five steps to install Autoware.AI. We created a workspace
in the PC and downloaded the workspace configuration for Autoware using the following commands:

1. git clone https://gitlab.com/astuff/autoware.ai/common.git
2. git clone https://gitlab.com/astuff/autoware.ai/core_perception.git
3. git clone https://gitlab.com/astuff/autoware.ai/core_planning.git
4. git clone https://gitlab.com/astuff/autoware.ai/docker.git
5. git clone https://gitlab.com/astuff/autoware.ai/drivers.git
6. git clone https://gitlab.com/astuff/autoware.ai/messages.git
7. git clone https://gitlab.com/astuff/autoware.ai/simulation.git
8. git clone https://gitlab.com/astuff/autoware.ai/utilities.git
9. git clone https://gitlab.com/astuff/autoware.ai/visualization.git

Check branch There could be several versions of the Git branch. We need to check out the "oap9" branch first. After
cloning the repositories, we navigated through each directory and checked out the desired branch ("oap9") using the git
checkout branch_name command. The following shell commands can also be used to check out all the repositories.

#!/bin/bash
for dir in autoware common core_perception \

core_planning docker drivers messages simulation \
utilities visualization; do

if [ -d "$dir/.git" ]; then
cd "$dir" && git checkout oap9)

else
echo "Skipping $dir, not a Git repository."

fi
done

Compile the Workspace After checking the branch, we continued the process and compiled the Autoware.AI with or
without CUDA support [25]. If desired, the following command can be utilized to compile Autoware.AI with CUDA
support:

AUTOWARE_COMPILE_WITH_CUDA=1 colcon build --cmake-args -DCMAKE_BUILD_TYPE=Release

4.4 Compile customized Autoware.AI

We noticed that the Git repository of Autoware.AI shared by the contractor does not have simulation features [26],
and parts of their codebases are still dependent on Python 2. As our ADS platform is configured for Python 3, we
encountered several issues requiring manual intervention and corrections. So, we ended up manually performing the
debugging process and eventually fixed the issues.

6



A PREPRINT - OCTOBER 10, 2024

After addressing the incompatibility issues within Autoware.ai, we created a private GitLab repository to manage
our modified version, with plans to make it public. Since Autoware.AI contains over a hundred packages, fixing and
compiling these packages is time-consuming and prone to errors. To streamline this process, we uploaded the compiled
version of Autoware.AI to our GitLab repository using the following command without recompilation [27]: git clone
https://gitlab.com/ruman23/autoware.ai.git

However, if we need to recompile the repository for any reason, all existing compiled files (except those in the "src"
directory) must be cleared to prevent potential conflicts or issues. This can be done by deleting folders such as "make,"
"install," and "log." After this cleanup, the compilation can proceed using the same commands used for the original
repository. This approach ensures a clean environment for a successful recompilation process.

4.5 Run Autoware.AI

There are several ways to use Autoware.AI, including running each node separately. The most convenient way to use
the runtime_manager is a GUI-based interface where we can easily simulate and control the testing AV. There are
two ways to launch the runtime_manager as explained below.

Method I In this method, we opened two terminals and set the source to run the ROS master and runtime_manager
in two different terminals.

1. First Terminal: We executed the command roscore to start the ROS master, a collection of essential services
that manage communication and coordination between different ROS nodes.

2. Second Terminal: After setting up the source in the second terminal, we continued and proceeded with the
following command to launch the runtime_manager.

roslaunch runtime_manager runtime_manager.launch

Note: the runtime_manager is a graphical interface used to manage and configure Autoware.AI. The .launch
file will have instructions on how to start the runtime_manager nodes and any other required nodes.

Method II While running the runtime_manager following Method I, we faced issues with proc_manager.
proc_manager in Autoware.AI is a component within the runtime_manager responsible for managing and monitor-
ing the execution of various processes and ROS nodes. It helps the runtime_manager start, stop, and restart processes,
ensuring the ADS runs smoothly and efficiently. This utility is important for maintaining the operational state of the
autonomous driving system, allowing for easy control and management of different modules. Using proc manager, AV
users can ensure that all necessary processes are active and that any issues during runtime are quickly addressed.

Missing ssh-askpass If there is an error about askpass, command sudo apt-get install ssh-askpass to install
the askpass package. The ssh-askpass is installed only once to fix the sudo permission issue error.

Missing jsk Fix the error of ModuleNotFoundError: No module named ’jsk_recognition_msgs’ by in-
stalling the jsk-recognition-msgs package:

sudo apt-get install ros-noetic-jsk-recognition-msgs

5 INTEGRATE VEHICLE INTERFACE TO AUTOWARE PLATFORM

To use Autoware.AI for the simulation, we need the ROSbag data of the LiDAR sensors, Point Cloud Maps, Vector
Maps, and Waypoints. We collected the LiDAR sensor data (in ROSbag format) using the testing AV, then generated the
maps and waypoints using different tools that will be discussed later. The following demonstrates how we integrated
Autoware.AI into the AV’s DBW and SSC interface platform using LiDAR sensor data to generate the maps and
waypoints.

5.1 LiDAR data collection

The process of LiDAR and camera collection is different from that of the DBW and SSC interface environments. To
collect LiDAR data using Autoware.AI, We first sourced the setup script to configure the environment. Then, we
further launched the Velodyne LiDAR driver to start receiving point cloud data from the VLP-32C (LiDAR) sensor.
Subsequently, we opened RViz software to visualize the LiDAR data in real-time and finally, used the rosbag command

7
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Figure 3: Play rosbag data in RViz.

(rosbag record -a) to record all ROS topics into a bag file for later analysis (Figure 3). The following commands
launch LiDAR data collection and visualization in the Autoware.AI environment.

source install/setup.bash
roslaunch velodyne_pointcloud VLP-32C_points.launch
rosrun rviz rviz -f velodyne
rosbag record -a

5.2 Downsample

After completing the LiDAR data collection (in the rosbag format), the next step is to downsample the file using
voxel_grid_filter. This downsample process is to improve the efficiency of Autoware.AI performance. The first
step is to rename the collected .bag data as bag_name and save it to the ’autoware.ai’ folder. We continued and launched
Runtime Manager and loaded the rosbag data to review the rostopics (e.g., velodyne_points) under the Simulation
tab followed by converting the velodyne_points to points_raw using the command [28] rosbag play -r 0.7
bag_name.bag /velodyne_points:=/points_raw. In the Terminal, we can use SPACE to stop the downsampling
process (Figure 4). This step is to enable the voxel grid filter from the Sensing tab to reduce the number of points in the
point cloud, so enhancing the processing efficiency in Autoware.AI.

Under ROSBAG Record, we continued to click Refresh and check points_raw. Then, rename the downsample file
and save it in the desired location (e.g., Autoware.AI), and activate Start. Since we were converting the entire dataset,
which means we were running the bag_name data until it was completed, we will wait for the running process to be
completed in the Terminal. Once enough data was yielded, we went to Runtime Manager and clicked Stop under
ROSBAG Record to complete the process (Figure 4).

5.3 Point cloud map collection

We can use the following steps to collect the points cloud maps from the rosbag data.

1. Open the Simulation tab and select the downsampling ROS bag file (Figure 5).

2. Click on the Play button to start the simulation.

3. Enable the voxel_grid_filter from the Sensing tab

4. Navigate to Computing - lidar_localizer - ndt_matching to start the process (Figure 6).

8
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Figure 4: An example of downsample process.

5. Open the application, select ref to define the path, and click on PCD OUTPUT to save the map in ASCII
format

6. Autoware.AI supports binary-formatted point cloud maps. To convert the ASCII-formatted PCD file into
binary, use the following command.

pcl_convert_pcd_ascii_binary source.pcd destination.pcd 1

Where ’1’ represents the binary format. ’0’ for ASCII format, ’2’ for binary compressed format.
7. To view the PCD file format, use the command head -n~20~file.pcd

5.4 Vector map generation

Autoware.AI requires a specific format for vector maps. We use the tool [29] provided by AutoCore to generate Point
Cloud Maps. The MapToolbox is a versatile tool that assists in creating and editing vector maps to meet the formatting
requirements of Autoware.AI. To correctly configure and utilize the MapToolbox, we followed the official guidelines
provided in the toolbox documentation. For more information and detailed steps, please refer to referenced documents
[29][30].

5.5 Waypoints generation

To generate waypoints from point cloud maps, we utilize the tools provided by Tier4 [31] as outlined below:

1. Open the tool and go to File → Import PCD to import the point cloud data.
2. To create waypoints, navigate through Create → Create Waypoints → Waypoints → Add Waypoints.
3. After adding the desired waypoints, save the waypoints by selecting File → Export Waypoints. The file is

saved in CSV format

5.6 Validation of Autoware in Autonomous Driving Systems

A driving simulation is performed to evaluate the effectiveness of Autowre.AI in operating ADS-equipped vehicles. To
successfully simulate and drive a vehicle, we must follow a structured sequence of operations. After setting up the
source, we must activate the LiDAR sensors by executing the command.

roslaunch velodyne_pointcloud VLP-32C.launch

9
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Figure 5: Play rosbag data in Runtime Manager.

Figure 6: ndt_mapping on rosbag data.

10
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Figure 7: An example of simulation in RViz.

This command may vary depending on the LiDAR sensor version. This step ensures the LiDAR sensor is ready to
capture and process point cloud data. Subsequently, we load the necessary Point Clouds, Vector Map, and transform
frames (TF) from the Map tab. We select the Localizer → Velodyne, Baselink to Localizer → TF, and Vehicle Model
from the Setup tab. The Localizer → Velodyne selection configures the system to use data from the Velodyne LiDAR
sensor, ensuring accurate localization based on the specific sensor’s characteristics. The Baselink to Localizer → TF
option guarantees that the transformations between the Baselink and the Localizer are correctly applied. Enabling the
Vehicle Model is needed to simulate and control the vehicle accurately because it provides its physical properties and
behavior. We select the voxel_grid_filter in the Sensing tab to refine the point cloud data.

Next, we configure the Computing tab in Runtime Manager. The waypoints, which are CSV files that direct the
vehicle’s path, can be loaded from the Motion Planning section by navigating to waypoint_maker and select-
ing waypoint_loader. Following this, several mission and motion planning options must be enabled. Under
Mission Planning, both lane_planner, lane_rule and lane_select options should be activated. Within the
Motion Planning category, the ‘waypoint_follower‘ options we selected are the purse_pursuit, twist_filter,
and wf_simulator. Additionally, the lattice_planner settings should be activated to improve motion plan-
ning precision, including lattice_velocity_set and path_select. Localization is another critical part of Auto-
ware.AI, where lidar_localizer must be configured by enabling ndt_matching and vel_pose_connect from
the autoware_connector.

Once these configurations are complete, we can launch the RViz and select the 2D Pose Estimate to initiate the
simulation process (see Figure 7). This step provides a GUI interface for monitoring the simulation. Finally, we
activate the drive-by-wire (DBW) system and the Synchronous Serial Controller (SSC), which the AutonomousStuff
provides to transition from simulation to driving the actual vehicle. Before enabling these controls, ensure the vehicle
is connected correctly, and all safety protocols are followed. The DBW system allows for electronic control of the
vehicle’s movements, while the SSC provides precise handling of the steering, throttle, and brake functions, translating
the commands from autoware.ai to the car.

Through the whole process presented for troubleshooting incompatibility issues in this paper, we have been able to
manipulate the ADS-equipped vehicle using the installed Autoware.AI, Ubuntu 20.04, and ROS 1 operating systems.

6 CONCLUSIONS

As the use of ADS-equipped vehicles continues to grow in transportation systems, the work of scholars in addressing
incompatibility issues between the Autoware platform and the vehicle interface is of paramount importance. This
comprehensive study provides a detailed solution to guide scholars in solving different issues among ROS, Ubuntu, and
Autoware. AI including:

11
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• Managing Python version on ROS 1 to solve incompatibility issues between Python 3 and ROS Noetic
• Installing system dependencies such as CUDA installation on Ubuntu 20.04
• Customizing Autoware.AI repository and successfully installing on Ubuntu 20.04
• Downsampling LiDAR data using Autoware to convert rostopics and improve the efficiency of Autoware.AI

performance
• Running simulation in Autoware.AI to ensure the vehicle’s safety and efficiency before the field test

After the successful integration of Autoware.AI, Ubuntu 20.04, and ROS 1, it will be recommended that further work
be done on the advanced integration of Autoware.Universe, Ubuntu 24.04 Noble Numbat, and ROS 2.
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